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GoldenGate RFIC Simulator Update Release Notes

GoldenGate 2020 Update 1.0 Release Notes
To download GoldenGate, visit the GoldenGate Software Downloads page.
To install GoldenGate, please refer to the GoldenGate Installation documentation.
To use Data Display, Momentum, supported Ptolemy sources and sinks, or ADE extensions with the 
GoldenGate RFIC Simulator, use ADS.
For information about other EEsof products, refer to the Keysight EEsof EDA Design & Simulation 
Software page.

Support discontinued for
Linux RHEL 5 
Cadence ADE version IC 5.1.41, 6.1.4, and 6.1.5

New Features in GoldenGate 2020 Update 1.2

Released in March 2021
VTBs can now have inputs in current
Support of ICADVM 20
Support of SiMKit 5.3
Addition for latest models:

HICUM Level 0 Version 2.00 and Level 2 Version 3.00
BSIM-IMG Version 102.94 and Version 103

Job Distribution:
Support of SiteCluster to unify setups with RFPro and ADS Circuit simulator

Improve parsing performance for large Spice model files (Pilot phase)

New Features in GoldenGate 2020 Update 1.1

Released in April 2020
Addition for latest models: 

HiSIM_SOI Version 1.40
HiSIM_HV Version 2.20
HiSIM_HV Version 2.40

Model improvements: 
UTSOI Version 2.20
UTSOI Version 2.30

Enhancements to the VTB flow:
Current sources as modulated inputs to the circuits are now supported in addition to voltage and
power sources.
Piecewise linear (PWL) sources are now available even in the Fast Envelope flow.

http://edadocs.software.keysight.com/display/support/GoldenGate+Downloads
https://edadocs.software.keysight.com/display/gg2020update1/Installation+Guide+for+Cadence+Analog+Design+Environment
https://www.keysight.com/in/en/products/software/pathwave-design-software/pathwave-rfic-design-software.html
https://www.keysight.com/in/en/products/software/pathwave-design-software/pathwave-rfic-design-software.html
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Parallel sources with same frequency are now taken into account.

New Features in GoldenGate 2020 Update 1.0

Released in February 2020

GoldenGate 2020 Update 1.0 is a major update of GoldenGate 2020 with the following 
enhancements:

Introduction of Compact Test Signals (CTS) to speed up EVM computations with Regular Envelope
Sharing an algorithm present in Keysight instruments, CTS aim at reducing the runtime of classical 
Envelope simulations by orders of magnitude

Model improvements:
SiMKit 5.2
BSIM-CMG 111

Various fixes
NFmin computation when using complex impedances
Fix of BSIM-CMG 108 Vth discontinuity using BSIM-CMG 111 equation
Fixed an error when using swept performances for ports at multiple of the fundamental
Speed up of S-Parameters when using large SP matrices
Fixed GUI issues when using sweeps with Multiple Ranges

Fast Envelope Levels 2 and 4 deprecation in GoldenGate 2021:

As Fast Envelope Level 3 is a superset of Level 2 and Level 5 a superset of Level 4, GoldenGate 
2020 releases will be the last ones using Fast Envelope Level 2 and Level 4. In case these levels 
are used, it is advised to switch either to Level 3 or Level 5 that are already available.
Starting GoldenGate 2021, only the Fast Envelope Level 1 (No Memory Effect), Level 3 (Memory 
effects extracted with sines), and Level 5 (Memory effects extracted with pulses) will be 
available. 

New Features  in GoldenGate 2020

Support for TSMC Model Interface (TMI) 2017
GoldenGate can work with models that use TMI (ETMI version 2017), the TSMC Model Interface.
TMI uses compiled code in a shared library file that is provided by the foundry as part of the transistor 
models for a semiconductor process.
For a PDK that uses TMI, GoldenGate will automatically locate, load, and use the correct shared library 
that comes with the PDK.

Multi-technology simulation is supported where models for some devices come from TMI and 
others are based on traditional Spectre or Hspice netlist files. 

TMI has not been qualified for use with SOI devices and aging simulations. Such simulations may run, 
but their accuracy is not guaranteed.
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Core Features

[GGATE-345], [GGATE-350]

Support for Cadence IC 618/ICADVM 18
Harmonic Balance improvements in speed and memory for large designs
[GGATE-472]
Various updates of non-linear models : BSIM-BULK 106.2, R2_CMC, R3_CMC, BSIM-CMG, HiSIM_SOI, 
HiSIM_HV, SiMKit
New Verilog-A compiler

Links with Electromagnetic Simulations
Ability to generate data to drive RFPro current excitation. For information on saving the RFPro current 
excitation, see  Save RFPro Current Excitation.
Support of reading SIO format for smaller S-Parameters footprint

Links with System Simulations
Support SystemVue 2018 Update1 and associated VTBs including new VTBs for 5GNR and IoT
New Fast Envelope modeling level for better handling of deep nonlinear memory effects
Introduction of Distortion EVM
VTBs now embed noise effects
GoldenGate can now generate parameterized FCE models.

The FCE models are supported from SystemVue 2020 only. For more details on the known issue, click 
here.

Pilot: Support of multiple SiMKit

Starting with the 2020 release, GoldenGate is delivering a pilot project to try using models from 
different SiMKit versions ahead of an official release.
You can activate the multiple SiMKit by turning on a registry variable in the configuration file. The 
variable is /goldengate/simkit/use_multiple_simkit. Valid values to activate the multiple SiMKit are 
1, on, true, and yes.

By default, the GoldenGate will use the latest SiMKit version. The multiple SiMKit will become the 
default in the future major release.

https://edadocs.software.keysight.com/display/gg2020update1/Setting+GoldenGate+Global+Save+Options#SettingGoldenGateGlobalSaveOptions-GlobalSaveOptionsOutputOptions
https://edadocs.software.keysight.com/display/gg2020update1/Using+the+Registry+File+to+Set+Variables
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Improvements
Support SystemVue 2018 Update 1.0 and associated VTBs, including new VTBs for 5G and NB-IoT.

Additional Support For
Models (in addition to those supported in last major release). For a complete list of supported models, 
see  Models Supported in GoldenGate .

BSIM-CMG 111.0.
SiMKit 5.1, 5.1.2, 5.2

Keysight EEsof Licensing and GoldenGate
GoldenGate requires: 

the version 2019.02 of the EEsof EDA licensing software
a minimum code-word version 2019.02 or above
the licensing server software, lmgrd and agileesofd, to be upgraded to at least the same versions 
as what are included in EEsof EDA Licensing software 2019.02. 

GoldenGate will not start if any of these requirements is not met. Refer to the License 
Codeword Version Compatibility Table.

In the EEsof EDA License Tools version 2019.02, licensing vendor daemon (agileesofd) is integrated 
with FlexNet FNP 11.13.1.4 version (Windows) and FlexNet FNP 11.13.1.3 version (Linux) of FlexNet 
license manager daemon (lmgrd). For the Windows platform, GoldenGate installer will automatically 
set up these two new license server daemons by default for the local node-locked license users; for 
the Linux platform, you need to follow the Linux/Solaris Licensing Setup instruction to complete the 
licensing configuration process. For more details, refer to Licensing (For Administrators).

Licenses supported in previous releases are no longer supported. For more information, see  
Licensing.

Platform Support

64-bit Linux:
Linux RHEL 6
Linux RHEL 7
SUSE Linux 11.x
SUSE Linux 12.x

Cadence ADE Support

Supported Versions
IC 6.1.6, 6.1.7, 6.1.8, and all subversions

https://edadocs.software.keysight.com/display/gg2020update1/Table+of+Models+Supported+in+GoldenGate
https://edadocs.software.keysight.com/display/gg2020update1/License+Codeword+Version+Compatibility
https://edadocs.software.keysight.com/display/gg2020update1/License+Codeword+Version+Compatibility
https://edadocs.software.keysight.com/display/gg2020update1/Setting+Up+Licenses+on+Linux+and+Solaris
https://edadocs.software.keysight.com/pages/viewpage.action?pageId=576842837
https://edadocs.software.keysight.com/pages/viewpage.action?pageId=576842837
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If you plan to use ADE Explorer (maestro views) with GoldenGate, you need to use IC 6.1.7.709 or 
later.

ICADV 12.1, 12.2, 12.3
ICADVM 18.1 

Documentation
Starting with the 2020 release, the online help gets a new user interface. The new UI improves 
overall online help usability by providing the following key benefits in addition to several other 
minor benefits:

Table of Contents Sidebar: Displays collapsible Table of Contents for the entire documentation. The 
left-double-arrow icon collapses the sidebar, and the right-double-arrow icon displays the sidebar back 
again.
PDF Button: Allows you to instantly generate PDFs of the latest documentation anytime, including 
current page’s children pages. Currently, the PDF generation option is available only for GG 2020 
release. For other releases, you can switch to their Printing Manuals page and download the existing 
PDFs like earlier. Note that with the introduction of PDF generation feature, the Printing Manuals page 
will not be available from next release onward.
Product Release Switcher: Allows you to view the current page in other supported releases listed in 
the drop-down menu. Once you select a release from the drop-down menu, the current page is 
updated to show the content applicable to the selected release. The Table of Contents is updated as 
well. With this, you bookmark URL of only one release and then switch to other releases from this 
drop-down menu.
Latest Documentation: The documentation available in the new UI is always kept updated for all 
supported releases. These updates are available to you as soon as they happen at our end. This 
provides you 24x7 access to the most recent and technically accurate documentation.

For more details, see How to Use Online Help.

Fixed Issues
Upgrade the GoldenGate to support the latest TMI version.
The SSB output noise results for psin component  in analogLib are read improperly.
GoldenGate simulation crashes even when the default carrier frequency is set to 450 MHz.
GoldenGate 2020, for the HiSIM_HV model a warning message is displayed when the parameter type 
is set to 0 ('TYPE' == 0).
For the R3 CMC model, the DC operating point parameters are not annotated.
Only the GoldenGate 2019 should contain the ADS versions 490 and 491 for the GoldenGate in ADS to 
work with ADS 2019 and ADS 2019 Update 1.0.
When performing Envelope Transient ( ET ) simulation with fast envelope level 1, an unexpected EVM 
result is found.
Cadence ADE IC 6.17.714 and ICADV 12.30.711 versions: The bus signal was not getting flattened to 
bits when printing the DC node voltage. 
Upgrade the GoldenGate to support the latest SystemVue 2018 Update 1.0.
Abnormal termination for the Envelope Transient analysis simulation with checkpoint period.
An error message appeared when selecting the Environment button in ADE.  

https://edadocs.software.keysight.com/display/gg2020update1/Printing+Manuals
https://edadocs.software.keysight.com/display/gg2020update1/Printing+Manuals
https://edadocs.software.keysight.com/display/gg2020update1/How+to+Use+Online+Help
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GoldenGate simulation crash error reported when carrier frequency set does not correspond to any of 
the frequencies of the envelope simulation.
Support the magnitude/phase format in I/Q data file for envelope sources.  
PSP 103.6 model: The output noise of GoldenGate was neither matching with ADS nor SPECTRE.   
GoldenGate simulator crashed or abnormally terminated when performing the ac noise analysis on a 
test bench that is written in SPICE format.  
Update GoldeGate with changes made to the BSIM-CMG version 106.  
Add support for the BSIM6 version 6.11.
For the Envelope Transient (ET) analysis, the parameters Step Size Control and  Integration Accuracy 
do not control the right simulator parameter settings.  
UTSOI2 version 2.3: Output currents during DC simulation in GG 2020 were not matching with that of 
ADS 2019.  
UTSOI2 version 2.3: Noise results of PMOS devices in GG 2020 were not matching with that of ADS 
2019.
GoldenGate parser reported error to handle the Spice nmos model (BSIM-IMG) with level parameter 
78.
Provide support for the BSIM-IMG version 102.91.
Provide support for Hspice global simulator option parameter with geoshrink set to 0.855.
Provide support of the BSIM-SOI version 4.61.  
Output currents in GoldenGate are not matching for Spectre BSIM-SOI with bias points soimod=2 and 
shmod=1
bicmos7wl PDK : Simulation fails when the default values for the minimum/maximum parameters 
conflict with the absolute parameters.
ICADVM version 181: Unable to launch the ADE Explorer from ADE state.
Provide support for the BSIM-IMG version 102.92.
BSIM-IMG 102.8, 102.91, and 102.92 models are unable to recognize the parameters rsc, rdc, and so 
on.
GoldenGate parser crash error reported.  
Include the Fast Envelope level 5 option in the ET analysis setup window.  
Abnormal termination reported for the  Conjugate Gradient  algorithm of ET sources when random 
seed was set to 30105.

Known Issues

System Integration
Custom VTB workspaces saved with an earlier version of SystemVue cannot be used as is and if 
you plan to use a saved workspace, then it must be opened in supported SystemVue and resaved.
SystemVue engine used by GoldenGate 2020 is evolved based on the updated SystemVue 2018 
Update 1.0 VTB engine. Due to this the VTB examples may provide different results for GoldenGate 
2020 and SystemVue 2018 Update 1.0. 
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1.

2.

3.

General Issues
In GoldenGate 2020 Update 1.0, if you have a state with "Multiple Ranges" Sweep Type option values 
defined, then loading the saved state might not work properly.
Workaround: You need to redefine the "Multiple Ranges" Sweep Type option values and save the 
state.

For the GF 22FDX Idfet model (ICADV 12.3 version), DC operating point parameters are not annotated 
and cannot be viewed.

Performing GoldenGate simulation with fast envelope level 3 provides inconsistent results.

For the GF12LP and GF14LPP models, the GoldenGate results are not matching with Spectre results.

LSF simulation with -mt option is unsupported for GoldenGate.

Increasing points in GoldenGate to 20 hangs Cadence Virtuoso IC 6.1.6.
Workaround: The issue has been resolved in Virtuoso version 6.1.7. Use the updated version.  

The Verification Test Bench (VTB) simulations are not supported in conjunction with parallel and 
Monte Carlo simulations.

An error is displayed when VTB simulation results are opened in DDS from linked ADS 2016.01.
Workaround: Use ADS 2016.01 update 4 or use the following procedure to convert the VTB results to 
DDS. 

The issue is resolved in ADS 2017 and later releases.

Browse to <simulation_dir>/psf directory. 
Where, <simulation_dir> is the path to simulation directory.
Execute the following command:
adx2ds <vtb_result>.adx 
Where, <vtb_result>.adx is the file created after VTB simulation.
Copy the <vtb_result>.ds  file to the <simulation_dir>/data directory.

GoldenGate does not support references to "$freq" in spectre expressions.
Workaround: GoldenGate provides a variable "GoldenGateFreq" to be used in place of "freq".

[142372]

SystemVue 2016.08 can not read FCE model file generated by GoldeGate 2017

- Removed in GG 2020 (information with references to 2017 updates as suggested by Tom)

absdelay() is not supported in Carrier (HB) analysis. The system issues the following error. 
The absdelay() operator is not currently supported in HB and ET analyses.
Parameter default in the nport device model. The default for the thermalnoise parameter is reset to 
match a new default in Spectre IC06.15.140 as following:
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Spectre GoldenGate Default
(in bold)

Before IC06.15.140 Before 2012.10 (4.7.2) thermalnoise=no (off)

IC06.15.140 and later 2012.10 (4.7.2) and later thermalnoise=yes (on)

In the designs that use analogLib nport devices with the thermalnoise parameter set to a default, 
you will see some differences in the noise outputs with GolenGate 2014.10 (4.9.0) and later releases. To 
reproduce the older results, set thermalnoise=off in the nport devices in your schematics.

Compatibility issues with Spectre devices from analogLib:
noisetemp is ignored in analogLib nport device

With SSNA and FYC selected, S12 and S22 do not vary with trials. Only S11 and S21 results are 
correct.
The Sweep Task is not supported for the parameters with mapped names.
XP Analysis is not supported in simulations with GDE.
New/Old UI forms:

Old states containing sweep task variables and saved with the old UI can miss variable definitions 
when opened with the new UI.
Workaround: When opening an old saved state with UI click on a variable entry in the sweep task 
listbox and apply, then resave the state.

In the Monte CarloTask:
Correlation variables that refer to the device instances are not supported.
When a PDK parameter is declared to have both process and mismatch variations only the last 
declaration (in a netlist) is accepted.
weight is ignored for Yield Goals.
When simulation has failed for some MC trials with the Local Parallel setting the results for the 
failed trials are not accessible.
When re-running a parallel Monte Carlo simulation, after changing the number of processes and 
trials, the output data does not get refreshed correctly in an existing qWave plot.
Workaround: Upload the updated data manually.

Instances of adsLib components inside model files will not be processed correctly if the Spectre 
format is set to be case-insensitive (simulator lang=spectre insensitive=yes). This is not an 
issue for most users that will be using the schematic editor.
Workaround: Edit the model files so a simulator lang=spectre statement would precede the blocks 
with the adsLib components declarations and the default case sensitive format would be applied.
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The use model of the Virtual Test Bench (VTB) has several restrictions that include:
Supported Analyses
The version of GoldenGate Tools it can be simulated with.
Signals it can handle.
Ports and simulation parameters settings
For more information refer to VTB Uses and Restrictions

After running a Momentum simulation, you may generate a symbol for the S-parameter model to 
reuse the data in the GoldenGate simulations. Note that in this case the symbol must be generated wit
h a grounded reference pin to run in GoldenGate. However, if you want to simulate the extracted view 
of a layout with a Momentum model for a part of the layout, you need to use the symbol for the S-
parameter model generated without a reference pin.
Current and voltage output information is not available in the DDS Results Viewer when either an 
input Digital State File or Ptolemy components with parameter sweeps are used.

In Cadence ADE
When simulation states are saved as the design cell views, opening several states simultaneously 
within the same ADE session might lead to state corruption.
Workaround: Reload the corrupted states with Session > Load States

In IC6.x ADE
In IC617, after running a simulation in GoldenGate and when viewing the results, click Plot:

A waveform appears the first time. However, with the next click, Plot or table, an error message 
appears indicating inability to plot the waveform again or get the table form of the waveform 
respectively.
A waveform appears and then select Waveform > send to > Calculator. An error message appears 
when the plot and table options are used in the calculator window.

  The above is working fine in IC 618/ICADVM 18 versions and later.

The Vir Probe, Vir Src, and Job Manager buttons are not displayed in the window
Workaround: Use the menu items instead to access to the Vir Probe, Vir Src and Job 
Manager settings, respectively, as follows:
Outputs > GoldenGate Probes ...
Setup > Virtual Source Editor ...
Simulation > Job Manager ...
A double-click on the Variables section in the ADE window launches the native dialog, not the one that 
belongs to the GoldenGate simulator.
Workaround: To access the GoldenGate dialog, use Variables > Edit ...
Please also refer to GoldenGate Integration into ADE-L and ADE-XL Test Editor documentation.

If you need to use the Skill debugger, set gcdisable=t in your .cdsinit file.
The Setup > Environment > Results View > Auto Plot Results After Simulation only works for 
performances and expressions. Same as plotting from the Plot icon.
Workaround: Create expressions in the Output > Setup. You can use the Cadence Calculator to help 
create expressions.

Oceanscript Issue
If a parameter's default value is "t" and users change it to "nil", it will give an error message and will 
not take the value so the default is used instead. This is a Cadence issue because Spectre behaves 

https://edadocs.software.keysight.com/display/gg2020update1/Virtual+Test+Bench#VirtualTestBench-VTBUsesandRestrictions
https://edadocs.software.keysight.com/display/gg2020update1/GoldenGate+and+ADE+Integration
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the same. To work around this please manually change your parameter value to "nil" in the 
oceanscript.
If oceanscript contains lengthy function calls which exceed 8192 characters then you can't redirect it 
to ocean at the command line. This is a Skill language limitation and is well documented in Cadence's 
documentation. Cadence proposes the following three workarounds:

workaround 1: invoke ocean at the command line, then load the file inside ocean.
workaround 2: 

Save the function definition to another file ("myFunction.il") and delete it from the ocean script. 
L oad the function with the help of a load statement in your ocean script  
load("myFunction.il") 
From command line type 
 %ocean < oceanScript.ocn 

workaround 3: If you want to exit from ocean at the end of the script. 
Add the "exit" statement at the very end of your ocean script. 
Load the ocean script as follows:
 %ocean -restore ocnScript. ocn 

SSNA Results
In rare cases, GoldenGate 2020 SSNA results might differ from GoldenGate 2017.
Workaround: Roll back to GoldenGate 2017 behavior by adding the below command in ADE-L menu C
md Line Params  (Setup→Environment, Simulation tab) 
   -analysis matrix_vector_loop=0
The issue will be fixed in the next minor update of GoldenGate 2020.

GoldenGate in ADS
Schematic (unnamed) Node Names
Handling of unnamed nodes is different in ADS than in Virtuoso®. By default, in Virtuoso® unnamed 
nodes use the format *** (for example, net1, net2, etc) whereas ADS uses N__*** (for example, N__1, 
N__2, etc). After an interoperable design is loaded in ADS, the original node names (net1, ...) will be 
kept until the design is modified or saved. At this point, the ADS defaults will apply. This may cause 
problems with GoldenGate virtual probes, since they refer to node names. A warning is displayed to 
redefine those probes.
Momentum Integration

Need to regenerate the old momentum views.
Parameterized layout is not supported.
In ADS, it is essential to generate a momentum view before running the simulation. This differs 
from the regular ADS flow.

Unsupported Elements
ADS primitive devices
Workaround: Use analogLib or interoperable PDK components
analogLib vsource, isource, port
Workaround: Use vsin, isin, vcd, psin instead of analogLib vsource, isource, port
P-cells (pcel) instances in a design
Verilog-A instances
ADS tools such as Optimization cockpit; Load Pull cockpit
Hierarchical Editor
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a.

b.
c.

The GoldenGate in ADS does not support a few GoldenGate features. For details, see RFIC Cockpit 
Limitations.
Spacing between value and multiplier are not supported by GoldenGate, e.g. '1 m', '0.5 u'.
The Copy from Schematic option copies the variables available in the right-side of the deactivated 
devices to the RFIC Cockpit.
In Virtuoso®, pins are used from the basic library. In ADS, pins are used from the standard ADS library 
available from the toolbar.
Simulating a virtual C-meter hierarchical probe gives error.
Workaround: To simulate a virtual C-meter hierarchical probe, either create a hierarchical current 
probe using Analysis > Save Options > Select from schematic or create a virtual probe and keep the 
‘Probe Name’ as hierarchy, for example: for NM0 transistor one level down the hierarchy, use Probe 
Name = NM0:d

Licensing 
Unable to install Licensing Hardware Key Drivers on Windows.
Workaround: Turn off UEFI Secure Boot (BIOS) and use the default 6.3 version of the Wibu key driver 
delivered with the EEsof Licensing tools.
Licensing may not support a license file path that is too long. This will likely occur when you have too 
many license files. 
Workaround: Remove some license files, move the license files to a shorter directory path or to 
combine license files into a single file.
License Setup wizard may not be able to start license server with many license files. During setup, it 
may lead to a situation where a command prompt window appears/disappears incessantly. This is 
due to the fact that License Setup wizard is not able to start lmgrd with a long command line and may 
get stuck in a loop.
Workaround: 

It is recommended to combine all license code words tied to same MAC ID into single license file 
to avoid setting large number of license files.
Try to use a shorter path to place license files.
If #1 and/or #2 does not help, start the license server (lmgrd.exe) from the command line (e.g. 
lmgrd.exe -c <lic-file-path> -l <license_server_log.txt>) and then set 
<PRODUCT>_LICENSE_FILE=<PORT-NUMBER>@localhost for product you want to use on same 
PC.

Dongle drivers for Flex-10 dongles on Linux are release specific. Installing the latest dongle drivers on 
Linux will function properly only for the most recent EEsof releases.
Workaround: Install and use dongle drivers as needed.  If you need to run the most recent EEsof 
releases, use the latest  Flex-10 dongle driver. If you need to use older releases, uninstall the latest 
dongle driver and re-install the older dongle driver
FLO and EEsof License setup are writing server logs at different locations. However, the EEsof server 
log file location is updated in the License Manager > Environment tab.
When multiple same-named INCREMENT lines of different version exist on the license server, few 
advanced FlexNet options to reserve/limit licenses may not work properly. 
Product Selector “Check Availability“ generates incorrect results (which leads to license failure) for 
older releases when multiple date base versions of like-named bundles exist in the license pool.
In Linux, Product Selector OK and Cancel Buttons locations are reserved.
Starting from FlexNet Publisher 2015 (also known as version 11.13.1), the adoption of the best 
practice of the least-privilege security therein results in the License Server related Windows Service to 
run with the LocalService Account privilege (instead of the LocalSystem privilege as before.)  Running 
with the LocalService Account privilege, an executable can no longer access any files located in the 

https://edadocs.software.keysight.com/display/gg2020update1/RFIC+Cockpit+Limitations
https://edadocs.software.keysight.com/display/gg2020update1/RFIC+Cockpit+Limitations
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a.
b.
c.

per-user specific type of folders.  As a result, any license file placed in those folders can no longer be 
accessed by the License Server when the License Server is automatically started via the Windows 
Service upon each PC reboot. For the local node-locked license, this would not result in any disruption 
to the usage of EEsof applications; however, for the license installed on a network PC that is accessed 
by multiple client PCs, this may cause EEsof applications not to start after the network PC reboots
Workaround: Store your license files in the Windows folders that are accessible by the LocalService 
Account privilege.  For example, C:\ProgramData or C:\users\public are both qualified choices.  In 
general, any folder that has the "Users" group listed in its Properties > Security page and this "Users" 
group has the read permission enabled should work. 
Using the default port to connect to a license server may cause a delay when checking out licenses. If 
no port is given in the license file, Flexera scans ports 27000 to 27009 to find the port. Starting from 
FlexNet Publisher 2015 (aka version 11.13.1), the default timeout for the response from each port 
increased from .1 seconds to 3 seconds.
To avoid the delay, KSM now issues licenses with port 27009 instead of leaving this blank. The EEsof 
License Setup Wizard (from Licensing 2017.01 onwards) handles some common situations such as: 
where it detects license file(s) without port, when users get a new license file with port 27009, or when 
all license files for a vendor daemon does not have same port.

You will not be able to start the license server if all license files for a vendor daemon on a server 
does not have same port.

Users who manually setup a license server or using EEsof License Setup Wizard with older licensing 
bits may need to manually edit license files to comply with the following rules:

All license files for a vendor daemon on a server must use the same port (or all be blank). 
Using the default port (blank) is allowed but may result in longer checkout times. 
If setting up a network server, select an unused port that is not blocked by a firewall.

Workaround: If the user cannot change the port, or wants to use the default Flexera ports, the 
environment variable FLEXLM_TIMEOUT can be set to .2 seconds (200000), to minimize the 
performance degradation. However, if the network latency is an issue in your environment, you may 
need to fine-tune this setting to minimize the general performance degradation while still 
accommodating the network latency.

Installation of EESof EDA tools (such as, SystemVue 2016.08, Genesys 2017.XX, or ADS 2017.XX) may 
hang at 4% (percentage vary based on the products) for few hours or even more on some specific 
machines.
Workarounds:

Disable Firewall setting in Anti-Virus Software installed on the PC.
or
Download and unzip process explorer from the below link and then invoke procexp.exe.
https://technet.microsoft.com/en-us/sysinternals/processexplorer.aspx
Right click on the wusa.exe process under <Product installer exe> and select KillProcess. Now it 
will continue the product installation.

After installing EESof EDA tools (such as, SystemVue 2016.08, Genesys 2017.XX, or ADS 2017.XX) 
successfully and try to invoke the software or License wizard, you may encounter “api-ms-win-crt-
runtime-l1-1-0.dll” missing error.
Workaround: Install the Update for Universal C Runtime in Windows .  On Windows 64-bit system 
systems, the file to install is x64 version of the Microsoft hotfix KB2999226. A copy of 
the Windows6.1-KB2999226-x64.msu Microsoft 64-bit hotfix installer can be found under the C:
\Program Files\Keysight\EEsof_License_Tools\bin directory.  The Microsoft hotfix KB2999226 

https://technet.microsoft.com/en-us/sysinternals/processexplorer.aspx
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can be found under the Update for Universal C Runtime in Windows  page at  https://
support.microsoft.com/en-us/help/2999226/update-for-universal-c-runtime-in-windows as well.
On a newly formatted RHEL system, the EEsof Licensing tools may fail to boot. This is because the 
FlexNet Publisher 2015 requires a certain rpm
Workaround: Under the EEsof product installation directory, there exists a utility script named "Linux_s
ys_check.sh" under the bin directory. Run this script to find out whether any rpm is missing; run this 
script with a "-y" command-line option to also have all the missing rpms automatically installed if you 
have the sudo or root privilege.
License server may stop recognizing Flex-10 dongle on some systems within a few hours after 
starting 
Workaround: If you experience this problem, install the latest WibuKey drivers from Wibu Systems.
Unable to install Flex-10 driver if Flex-9 dongle is already plugged into a machine
Workaround: Before installing a Flex-10 driver for the first time, unplug the Flex-9 dongle.
There is a known FlexNet Publisher issue, whereby mixing node-locked codewords and floating 
codewords in one license file can result in: a) Remote simulations not working or b) A second local 
simulation not working in case the license is node-locked and also has incorrect version.
Workaround: It is strongly recommended that you do not mix node-locked codewords and floating 
codewords in one license file nor in any configuration that ends up with node-locked codewords and 
floating codewords both available on the same server. In other words, put the node-locked license and 
the floating license on different servers, and point to the respective one based on what you need to 
run.
If a user simultaneously runs two instances of a product and has mixed different versions of the same 
codeword on one license server, extra licenses may be pulled and result in unexpected “Licensed 
number of users already reached for this feature” errors.
Workaround: We recommend you remove expired codewords, to separate out the new and the old 
versions of codewords into different files and different servers, and to point to the respective one 
based on what you need to run.
Not specifying the TCP/IP port for the license server during license setup may lead to unexpected 
behavior and/or license checkout failure on the Windows platform. We strongly recommend you to 
always explicitly specify the TCP/IP port associated with each license server.
A node-locked and floating bundle operating on Linux cannot be shared between products using EDA 
License Tools version older than 2014.01 when run at the same time.
License Setup Wizard does not remove any previous user-configured FLEX Windows License Service 
manually set up by a user using FlexNet's lmtools. 
Workaround: You must remove the previous user-configured Windows License Service via lmtools.

Run the lmtools.exe from C:\Program Files\Agilent\EEsof_License_Tools\bin to invoke the 
lmtools utility. The lmtools utility window is displayed.

If you have installed an EEsof product released before 1st August, 2014 on your system prior 
to installing an EEsof product released after 1st August, 2014 then the default EEsof 
Licensing tools path will remain C:\Program Files\Agilent\EEsof_License_Tools. On 
the systems that only have EEsof products released after 1st August, 2014 installed then the 
default EEsof Licensing tools path will be C:\Program 
Files\Keysight\EEsof_License_Tools.

In the Service/License File tab, check the Configuration using Services option. All user-configured 
FLEX Windows License Services will be listed.
Select the service you wish to remove.
Select the Config Services tab and click the Remove Service button to remove the service.
To ensure that the license service or lmgrd is running, click View Log. A log window appears that 
confirms whether agileesofd and lmgrd are up and running.

While running multiple versions of prior GoldenGate releases together, set 
GoldenGate_MAXIMUM_BUNDLE_USAGE=ON in your environment so that all of them will use the 

https://support.microsoft.com/en-us/help/2999226/update-for-universal-c-runtime-in-windows
https://support.microsoft.com/en-us/help/2999226/update-for-universal-c-runtime-in-windows
https://www.wibu.com/
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same method to check out licenses. Otherwise, you might receive an error message, "Licensed 
number of users already reached".
On some Windows 7 machines, when more than one definition of an Ethernet adapter exists 
(duplicates), license checkouts may appear to hang up.
Workaround: Disable the duplicate network card definitions in your network settings: Control Panel > 
Network and Internet > Network Connections. This issue has been acknowledged by Flexera and they 
have created a bug report (SIOC-000103097).
For LSF style distributed simulations, ensure that the PATH on the client computer points to the 
$HPEESOF_DIR/EEsof_License_Tools/${architecture} directory that corresponds to the EEsof release 
being used. This needs to be done in order to ensure that the proper version of the Flexera utilities 
(like lmutil ) gets picked up in the path before any older in-compatible versions (that may also be 
installed on a users’ system.)
License Setup Wizard ( aglmwizard.exe ), which is used to set up and record the license path would 
not work if you already have an environment variable set for GoldenGate_LICENSE_FILE.
Workaround: You can use GoldenGate_LICENSE_FILE variable to point to license file or refer to 
Licensing (For Administrators).
The License Setup Wizard will exit or not properly configure a license server, if the server has all of its 
licenses currently in use.
Workaround: Wait for a license on the server to become available as you normally would before 
launching the product.
Unable to set license in case unicode characters are used either in path or license file name because 
the Flex License Service does not support these characters.
The Product Selector tool will be unable to display the license server status properly when connected 
to older license server.
Workaround: Upgrade your license server to the latest version.
EEsof Licensing Tools installer can hang on systems with McAfee LiveSafe installed and running the 
default firewall settings.
Workaround:  Prior to installing EEsof Licensing Tools, temporarily turn off the McAfee LiveSafe 
firewall.

Licensing setup steps on systems with McAfee LiveSafe installed can fail.
Workaround:  Under the McAfee LiveSafe firewall settings, under Port and Settings, allow the use of 
port 27001 for lmgrd.exe under the EEsof Licensing Tools installation bin directory.  Under Internet 
Connections for Programs , enable lmgrd.exe, aglmmgr.exe and aglmwizard.exe for all devices and 
turn off monitoring.

On Windows, EEsof product releases prior to 2014 can have boot time issues with licensing if an 
newer EEsof product is installed prior to installing the older product. For example, if a users installs 
Advanced Design System 2017 and then installs Advanced Design systems 2014.01, the user can 
have boot time errors with ADS 2014.01.
Workaround:  For Advanced Design System users,  set a system environmental variable named 
ADS_LICENSE_FILE under the Control Panel/ System, and Security / System / Advanced system 
settings and under the "environmental variables".  Add an System variable named 
ADS_LICENESE_FILE and the value will be the path to your local license file or the port@host setting 
for your site.

Removed in GG 2020 (information with references to 2017 updates as suggested by Tom)

When the same user is running similar simulations from multiple sessions of GoldenGate on the same 
computer and display—that is, the same User-Display-Host— and if simulations are rerun an extra 
license may be pulled.
Workaround: Select Simulation > Stop in all the GoldenGate sessions to release all the simulator 
licenses, then rerun the simulations.

https://edadocs.software.keysight.com/pages/viewpage.action?pageId=576842837
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Documentation
GoldenGate online help is not supported on the Google Chrome browser.
Workaround: Use Internet Explorer or Firefox to view GoldenGate documentation.
If the GoldenGate help does not show any content, throws an error, or does not display any search 
results.
Workaround: Close the help and delete the contents of the following directory:

On Windows 7: C:\Users\<Windows_Login_ID>\AppData\Local\Keysight\Help
On Linux: $HOME/.local/share/Keysight/Help

GoldenGate QT search does not support [] or {} or any other text using these combinations.

Compatibility table for GoldenGate in ADS

GoldenGate Version ADS Version

2020 Update 1.2 2021 and later

2020 Update 1.1 2020 Update 1.0 and 2020 Update 1.1

2020 Update 1.0 2020 Update 1.0

2020 2020

2019 Update 1.0
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